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Overview of CPS XE "CPS:overview" 

 XE "Overview:CPS" 
The Contract Payment System (CPS) consists of a Web-based front-end application used by Oregon Department of Transportation (ODOT), consultant and local agency Project Managers, and the ODOT Contract Administration Unit in support of payments made to Construction Contractors for services provided and materials used for ODOT highway and bridge construction projects.  

To initiate a project record within CPS, the ODOT CPS mainframe application downloads construction contract data. As a Contractor performs work and this is captured within CPS, CPS uploads the data to the ODOT CPS mainframe application to generate payment vouchers and update contract records. The Contract Administration Unit approves the payment vouchers and submits them to ODOT Financial Services to generate payments to Contractors.  

NOTE:  Payments to consultants and contractors for other types of services (e.g., personnel services, purchasing, etc.) are not made through CPS.  

More specifically, CPS allows a user to:

· Enter pay notes for bid/pay items for a progress estimate

· Consistently apply business rules and validations to maintain data integrity

· Create pay items for payment of materials on hand (MOH)

· Create price adjustment items

· Enter contract change orders, extra work orders or force orders (Contract Administration Unit only)

· Create progress estimates files

· Approve progress estimates for upload to the mainframe

· Generate reports on preliminary progress estimates

· Maintain contract payment history

Before using CPS, an individual should have a basic understanding of construction contract administration and be familiar with the ODOT Construction Manual, The Standards Specifications for Highway Construction and project-specific plans and specifications.

Contract Payment Process XE "Contract:payment process" 

 XE "Process:contract payment" 
The contract payment process begins when ODOT awards a construction contract to a Contractor and establishes the project authorization for the contract. The project authorization is the estimated cost of the project and consists of the Contractor’s original bid amount, anticipated items, contingencies and construction engineering. A reiterative process occurs to update, execute and make payments on the contract as the work progresses until the Contractor completes all work. 

The contract data is entered in, and made available through, Trns.port, ODOT’s construction management system. This data is electronically transferred to the CPS mainframe application. Contract Administration verifies and corrects, if needed, contract information on the CPS mainframe application. A contract payment file is initially established on the CPS mainframe application and then downloaded to and made available from the CPS Web-based application.  

The contract update process allows Contract Administration to add new payment items such as contract change orders, state force orders, extra work orders and price adjustments to the contract after work has begun. Contract Administration enters changes into the CPS Web application, prints log reports and runs a nightly process to synchronize the CPS mainframe and Web databases.

The contract execution process allows the Project Managers to document completed work on contracts and to authorize progress payments for the completed work.

The Project Manager enters the quantity of work performed into the CPS Web application based on pay notes generated by the project inspector, creates a progress estimate, and marks it for upload that triggers a review and approval process by Contract Administration. If Contract Administration approves the progress estimate, this triggers the system to send the progress estimate to the CPS mainframe application.

The Project Manager must maintain, in the project office files, all records necessary to support and justify the quantities and payments made on each progress estimate. Each payment must stand on its own if subjected to an audit.

The contract payment process allows payment to Contractors for work completed on construction contracts. When Contract Administration receives a preliminary progress estimate report (one marked for upload), they verify progress estimate amount numbers and mark the preliminary progress estimate as approved. This approved status triggers the upload process that makes it possible for Contract Administration to generate a CPEDIT report on the CPS mainframe application, which prints in Contract Administration and the ODOT Project Manager offices.  XE "Reports:CPEDIT" 

 XE "CPEDIT" Contract Administration then generates a preliminary voucher with a signature sheet on the CPS mainframe application that prints on their printer.

Figures are then double checked and retainage calculated. The Contract Administration staff member who prepares the progress estimate signs and dates the signature sheet. The Contract Administration Engineer also signs and dates the signature sheet when approving the payment. 

Contract Administration then runs the payment program, which generates the CPPROEST report on the CPS mainframe application.  XE "Reports:CPPROEST" 

 XE "CPPROEST" It also prints in Contract Administration and the ODOT Project Manager office. The payment program also generates the payment vouchers.

NOTE:  This user guide is designed for Project Managers and describes the functionality of CPS from a Project Manager perspective. Therefore, CPS may have a different functionality or appearance for individuals authorized with view-only or administrative access.

Requesting Access to CPS XE "CPS:register" 

 XE "Register:CPS" 
Internal ODOT Users

Internal ODOT employees who need access to CPS should contact the ODOT Contract Administration Unit to request this. If you have already been given access to CPS, refer to Accessing CPS for information on how to access CPS.

External ODOT Users

External individuals who need access to CPS may directly contact the ODOT Contract Administration Unit to request this or submit a request online. To make an online request, the ODOT Contract Administration Unit will provide a link to a Web page to submit this request. Refer to Figure 1 below. 

If you have already been given access to CPS, refer to Accessing CPS for information on how to login to CPS from the Internet.

To submit an online request to access CPS:

Step
Action
Comments/Results

1.
Use your Internet browser to go to the CPS link provided by ODOT.
The Login to Contract Payments System page opens. Refer to Figure 1 below.

2.
Click Request an Account.
The CPS PIN Request Form opens. Refer to Figure 2 below. 

3.
Business Name—Enter your business name.
Required field.

4.
Phone No—Enter your business phone number.
Required field.

5.
Contact Name—Enter your name as the contact person for your business.
Required field. Format is last name, first name.

6.
Email Address—Enter your e-mail address. 
Required field. This should be the e-mail address for the person entered in Contact Name. Confirmation of your request will be sent to this address.

7.
Effective Date—Enter the date you would like your access to be effective.


8.
Comments—Enter any comments about your request, as applicable.


9.
Click Reset to clear all of the fields on the form, if needed.


10.
Click Submit to submit your request.
If all required fields are completed, the CPS PIN Request Review page opens. Refer to Figure 3 below.

11.
Review the information you have entered. If you see an error, click your browser’s Back button to return to the previous page.


12.
If all the information is correct, click Submit.
The CPS PIN Request Results page opens, providing confirmation that the request has been received and confirmation will be sent to the e-mail address provided. Refer to Figure 4 below.

NOTE: If an account was already setup for the submitted e-mail address, then an error message appears advising that no new account has been established.

Figure 1. Login to Contract Payments System Page for External Users
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Figure 2. CPS PIN Request Form
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Figure 3. CPS PIN Request Review Page
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Figure 4. CPS PIN Request Results Page
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Accessing CPS XE "CPS:access" 

 XE "Access:CPS" 
Internal ODOT Users

Internal ODOT employees who use CPS will be provided a link/shortcut to the online application to place on their computer desktop. When the link is activated/selected, CPS opens to the Contract List. Refer to The Contract List for more information.

NOTE:  This user guide is designed for Project Managers and describes the functionality of CPS from a Project Manager perspective. Therefore, CPS may have a different functionality or appearance for individuals authorized with view-only or administrative access.

External ODOT Users

External ODOT users of CPS will be provided a link/shortcut to the Web application to place on their computer desktop. When the link is activated/selected, a login page opens. Refer to Figure 5 below. XE "Login" 

 XE "CPS:login" 
To access CPS:

Step
Action
Comments/Results

1.
Use your Internet browser to go to the CPS link provided by ODOT.
The CPS login page opens. Refer to Figure 5 below.

2.
Login Name—Enter your assigned user name. 
This is your e-mail address.

3.
PIN—Enter your assigned PIN.
If you forgot your PIN, click the Forget Your PIN? link. A page opens for you to enter your Login Name and then click Submit. Another page opens, displaying your reminder question. Enter the appropriate answer and click Check Answer. If the answer is correct, then a confirmation page opens advising you of this. The system generates a new PIN and sends this to you in an e-mail message.

4.
Click Log In.
The Contract List page opens with a list of all active contracts assigned to you. Refer to The Contract List for more information.

NOTE:  If you do not have a CPS account, refer to Requesting Access to CPS for more information on how to request one.

Figure 5. Login to Contract Payments System Page for External Users
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NOTE: Before you use CPS, you may want to turn on the AutoComplete settings within Microsoft® Internet Explorer. When entering information into CPS, the AutoComplete function will list possible matches from entries you’ve typed before. To turn this function on:

1. From Internet Explorer, select Tools > Internet Options. The Internet Options window opens.

2. Select the Content tab. 

3. Under Personal information, click AutoComplete. The AutoComplete Settings window opens. 

4. Under Use AutoComplete for, select the Forms checkbox. 

5. Click OK to close the AutoComplete Settings window.

6. Click OK again to close the Internet Options window.

The Contract List XE "Contract list" 
When you login to or access CPS, the Contract List opens with a list of all the contracts assigned to you. Refer to Figure 6 for an illustration of the Contract List.

NOTE: This user guide is designed for Project Managers and describes the functionality of CPS from a Project Manager perspective. Therefore, CPS may have a different functionality or appearance for individuals authorized with view-only or administrative access.

Figure 6. Contract List
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The Contract List displays all current (or open) contracts assigned to you in ascending order by contract number. For each contract listed, it includes the contract number, a link to bid/pay items, section name, progress estimate number, current authorization and corrected estimated amounts, performed to date, balance, performed since last estimate, Project Manager, Region Manager and Contractor.  XE "View:contract list" 

 XE "Contract list:view" 
From the Contract List, you may:

· Filter or sort the listed contracts based on Contractor, Section or Region Manager.

· Select a contract record for further viewing or updating.

· Select the bid/pay items for a specific contract for further viewing or updating.

· Go to the CPS Reports page to generate preliminary progress payment reports, quantity ledger reports, expenditure reports or compute mobilization andTP&DT.

· Logout of CPS.

NOTE:  To navigate within CPS, use its navigation tools/links rather than your Internet browser’s tools to move back and forth between pages. An exception to this is when viewing reports online. Refer to CPS Reports for more information on generating and viewing online reports.

Locating specific contract records XE "Locate:contract" 

 XE "Contract:locate" 
To locate a specific contract on the Contract List:

· Enter search criteria (Contractor, Section and/or Region Manager) and click Submit to create a filtered Contract List with just those contracts that meet the specified criteria or

· Scroll through the list or

· Use the arrow buttons to view the first, previous, next or last page of the Contract List.

Opening specific contract records XE "Open:contract" 

 XE "Contract:open" 
To open a specific contract record on the Contract List: 

· Enter a specific contract number in the Go To Contract field and click Go or

· Left click on the selected contract number or

· Right click on the selected contract number and select Open
When you select a specific record to open, the Contract record appears. Refer to The Contract Record for more information.

Viewing bid/pay items XE "View:bid/pay item" 

 XE "Bid/Pay item:view" 
To view bid/pay items associated with a contract listed on the Contract List, click the Bid/Pay Items link for a specific contract. This will open the Bid/Pay Item List for the selected contract record. Refer to Bid/Pay Items for more information.

Accessing the CPS Reports page XE "Reports:access" 

 XE "Access:reports" 
To access the CPS Reports page, click the Reports link that appears in the left-hand navigation bar on most CPS pages. This will take you to the CPS Reports page where you may generate preliminary progress estimate reports, quantity ledger reports expenditure reports or compute mobilization andTP&DT. Refer to CPS Reports for more information.

Logging out of CPS XE "Logout" 

 XE "CPS:logout" 
To log out of CPS, click the Logout link that appears in the left-hand navigation bar on most CPS pages. A page appears to confirm that you want to logout. Click Logout Now to logout (which takes you to the Login to Contract Payments System page) or click Back on your browser’s menu bar to return to CPS.

NOTE: Before you use CPS, you may want to turn on the AutoComplete settings within Microsoft® Internet Explorer. When entering information into CPS, the AutoComplete function will list possible matches from entries you’ve typed before. To turn on this function:

1. From Internet Explorer, select Tools > Internet Options. The Internet Options window opens. 

2. Select the Content tab. 

3. Under Personal information, click AutoComplete. The AutoComplete Settings window opens. 

4. Under Use AutoComplete for, select the Forms checkbox. 

5. Click OK to close the AutoComplete Settings window.

6. Click OK again to close the Internet Options window.

The Contract Record XE "CPS:contract" 

 XE "Contract" 
The Contract record is used to update or maintain contract information. Refer to Figure 7 for an illustration of a Contract record. 

The first time you open a contract record, it contains data that has been received from the CPS mainframe application. If you have view-only authority, you may only view the information. If you have read and write authority, you may update some of the information.  XE "View:contract" 

 XE "Contract:view" 
Figure 7. Contract Record
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NOTE:  Contact the CPS system administrator for more information on CPS authority levels.

From the Contract record, you may:

· View or update selected information on a contract.

· Return to the Contract List or go to a specific contract record to view or update. Refer to The Contract List for more information.

· Go to the Progress Estimates page for the selected contract. Refer to Progress Estimates for more information.
· Go to the Bid/Pay Items List for the selected contract. Refer to Bid/Pay Items for more information.
· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports or compute mobilization and percent of project complete. Refer to CPS Reports for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar. 

· Create new material on hand (MOH), adjustment or pending contract change order. Refer to Creating a New MOH Item, Creating a New Adjustment Item and Creating New Pending Contract Change Orders, respectively for more information.

· Go to a specific bid/pay item within a contract. Enter the bid/pay item and/or group number in the fields in the left-hand navigation bar and click Go. If multiple items meet the entered criteria, then the Bid/Pay Item List appears, displaying all of the bid/pay items for the contract that meet the entered search criteria. If only one bid/pay item meets the entered search criteria, the Bid/Pay Item window opens for the specific item. Refer to Bid/Pay Items for more information.

Updating contract records XE "Contract:update" 

 XE "Update:contract" 
On the Contract page, you may enter the estimated completion and second notification dates, plant establishment period and add comments to the record.

To update a contract record:

Step
Action
Comments/Results

1.
Locate the desired Contract record to update.
Refer to The Contract List for information on how to locate a specific Contract record.

2.
Est Completion Date—Enter the estimated completion date.
Format is MM/DD/YYYY.

3.
2nd Notification Date—Enter the second notification date, if applicable.
Format is MM/DD/YYYY.

4.
Plant Establishment Period—Enter the number of years for the plant establishment period, if applicable.


5.
Remarks—Enter any remarks as applicable to the contract.


6.
Click Reset to clear and not save the contract information you have entered.


7.
Click Submit to save the change(s) to the contract.


Bid/Pay Items XE "Bid/Pay item" 

 XE "CPS:bid/pay items" 
The Bid/Pay Item function within CPS allows authorized users to add and update bid/pay items on a contract. As the user changes or adds a bid/pay item record, the system applies business and validation rules. Users without update authority may only view a bid/pay item and associated pay note data.

You may access the bid/pay items for a contract from the Contract List or the Contract record. From a selected contract, you may only view the bid/pay items and pay notes associated with it. Refer to Pay Notes for information on pay notes.

To view bid/pay items associated with a contract:

· On the Contract List, click the Bid/Pay Items link for a specific contract to open the Bid/Pay Item List for the selected contract record. Refer to Figure 8.

· On the Contracts record, click the Bid/Pay Items link in the left-hand navigation bar to open the Bid/Pay Item List for the selected contract record. Refer to Figure 8.

· On the Contract List or Contracts record, enter the bid/pay item and/or group number in the fields in the left-hand navigation bar and click Go. If multiple items meet the entered criteria, then the Bid/Pay Item List appears, displaying all of the bid/pay items for the contract that meet the entered search criteria. Refer to Figure 8. If only one bid/pay item meets the entered search criteria, the Bid/Pay Item window opens for the specific item. Refer to Figure 9.

The Bid/Pay Item List displays all current bid/pay items in ascending order that are associated with the selected contract. For each bid/pay item listed, it includes the bid/pay item number and group, the number of pay notes for the bid/pay item, the name of the bid/pay item, the unit price for the bid/pay item and its unit of measure, original authorization quantity and amount, corrected estimated quantity and amount, performed to date quantity and amount, balance quantity and amount, and performed since last estimated quantity and amount. In addition, amount totals appear at the bottom of the Bid/Pay Item List. 

Figure 8. Bid/Pay Item List
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NOTE:  When a bid/pay item appears bold on the Bid/Pay Item List, then the paid to date quantity/amount equals the corrected estimated quantity/amount.

From the Bid/Pay Item List, you may:

· Return to the Contract record or Contract List; click the appropriate link in the left-hand navigation bar.

· Go to a specific contract record to view or update; in the Go To Contract field, enter the contract number and click Go.

· Select a specific bid/pay item to view or update its details. Refer to Updating an Existing Bid/Pay Item.

· Create a new Materials on Hand (MOH) item. Refer to Creating a New MOH Item.

· Create a new Adjustment item. Refer to Creating a New Adjustment Item. 

· Create new pending contract change order.  Refer to Creating New Pending Contract Change Orders.
· View the number of pay notes associated with an existing bid/pay item and go to the corresponding Pay Note List. Refer to Pay Notes for more information about this.

· Go to the Progress Estimates page for the corresponding contract. Refer to Progress Estimates for more information.
· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports or compute mobilization. Refer to CPS Reports for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar.  

Locating specific bid/pay items XE "Bid/Pay item:locate" 

 XE "Locate:bid/pay item" 
To locate a specific bid/pay item on the Bid/Pay Item List:

· Enter search criteria (Bid/Pay Item, Group and/or Lump Sum) and click Submit to create a filtered Bid/Pay Item List with just those bid/pay items that meet the specified criteria or

· Scroll through the Bid/Pay Item List or

· Use the arrow buttons to view the first, previous, next or last page of the Bid/Pay Item List or

· Enter the bid/pay item and/or group number in the fields in the left-hand navigation bar and click Go. If multiple items meet the entered criteria, then the Bid/Pay Item List appears, displaying all of the bid/pay items for the contract that meet the entered search criteria. Refer to Figure 8. If only one bid/pay item meets the entered search criteria, the Bid/Pay Item window opens for the specific item. Refer to Figure 9.

NOTE:  To locate material on hand (MOH) items, enter 7 in the Bid/Pay Item field and click Submit. A filtered list of 7000 series items appears.

To locate price adjustment items, enter 6 in the Bid/Pay Item field and click Submit. A filtered list of 6000 series items appears.

Opening specific bid/pay items XE "Bid/Pay item:open" 

 XE "Open:bid/pay item" 
To open a specific bid/pay item on the Bid/Pay Item List: 

· Enter item and/or group number in Go To Item in left-hand navigation and click Go or press Enter, or

· Left click on the selected bid/pay item number, or

· Right click on the selected bid/pay item number and select Open
When you select a specific bid/pay item to open, the Bid/Pay Item window appears. Refer to Figure 9. On the Bid/Pay Item window, you may:

· View bid/pay item details, including materials on hand if applicable.  

· Update the corrected estimated quantity of the bid/pay item.

· Lock the bid/pay item to prohibit new pay notes or updates to existing pay notes for the bid/pay item. 

Refer to Updating an Existing Bid/Pay Item for more information.

Updating an Existing Bid/Pay Item XE "Bid/Pay item:update" 

 XE "Update:bid/pay item" 

 XE "Bid/Pay item:modify" 

 XE "Modify:bid/pay item" 

 XE "Protect:bid/pay item" 

 XE "Bid/Pay item:protect" 

 XE "View:bid/pay item" 

 XE "Bid/Pay item:view" 
You view, update or lock an existing bid/pay item on the Bid/Pay Item window. Refer to Figure 9 below.

NOTE:  All entries must have adequate supporting documentation to justify payment. Refer to Chapter 12 A-H of the ODOT Construction Manual for more information. If you have questions, contact Contract Administration at 503-986-3028.

Figure 9. Bid/Pay Item Window
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When you first open a bid/pay item record, it always contains data that has been received from the CPS mainframe application. If you have view-only authority, you may only view the bid/pay item and related information. If you have read and write authority, you may update some of the bid/pay item and related information.  

NOTE:  Contact the CPS system administrator for more information on CPS authority levels.

To view or modify the bid/pay item record:

Step
Action
Comments/Results

1.
On the Bid/Pay Item List for the selected contract, select and open the specific bid/pay item you want to view or update.
The Bid/Pay Item window opens. Refer to Figure 9 above.

2.
Update the Corrected Estimate Quantity or, for Extra Work and Force Order Work, update the Corrected Estimate Amount.
Corrected Estimate Quantity may not be less than Performed to Date Quantity. For lump sum bid/pay items or split bid/pay items, Corrected Estimate Quantity may not exceed 100.

3.
Check the box to lock the bid/pay item from additional pay notes or changes to existing pay notes.
Use this feature when there will be no further payments made for the bid/pay item (e.g., release of retainage for subcontracted work).

4.
Click Reset to clear and not save the bid/pay item information you have entered.


5.
Click Submit to save the change(s) to the bid/pay item.


From the Bid/Pay Item window, you may also:

· Go to the next or previous bid/pay item or pay notes using the Fast Item Navigation feature.

· Return to the Bid/Pay Item List, Contract record or Contracts List, or go to another contract record.

· Go to the Progress Estimates window for the contract. Refer to Progress Estimates for more information.

· View a list of existing MOH for the selected bid/pay item, if applicable.

· Create a new MOH item. Refer to Creating a New MOH Item.

· Create a new adjustment item. Refer to Creating a New Adjustment Item. 

· View pay notes associated with an existing bid/pay item. Refer to Pay Notes for more information about pay notes.

· Create a new pending contract change order.  Refer to Creating New Pending Contract Change Orders.
· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports or compute mobilization. Refer to CPS Reports for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar.  

Creating a New MOH Item XE "Bid/Pay item:create MOH" 

 XE "Create:MOH item" 

 XE "MOH:create" 
You may create a new materials on hand (MOH) item from either the Bid/Pay Item List, the Bid/Pay Item window or any other window within a selected contract record. You may associate one bid/pay item with more than one MOH.

NOTE:  All entries must have adequate supporting documentation to justify payment. If you have questions, contact Contract Administration at 503-986-3028.

When creating a new MOH (7000 series) item, consolidate materials for some items to reduce the number of MOH entries on an estimate (e.g., with a traffic signal with many parts). You may do this by establishing a maximum theoretical price for all materials for the item as 100 percent and then paying for the actual MOH as a percent of the maximum theoretical price. Another method is to use a unit of DOLLAR and a unit price of 1. The quantity and amount are the same, reducing the chance of error. Whenever possible, use the same unit as the associated bid/pay item. As material is paid for under the bid/pay item, the same number of units is deducted under the MOH item.

The Project Manager must assure that the price paid for MOH leaves an adequate value to complete the required installation. Use force account procedures to estimate installation costs, which are typically at least 10 percent of the bid amount. CPS does not allow payment for MOH if the amount exceeds the available balance for the associated bid/pay item.  If multiple MOH items are associated with one bid/pay item, the sum of the MOH items cannot exceed the available balance for the associated bid/pay item.

NOTE:  Also refer to the Materials on Hand section (12-F) of the ODOT Construction Manual and Section 00195.60 of The Standard Specifications for Highway Construction for conditions that must be satisfied before payment can be made.

To create a new MOH item:

Step
Action
Comments/Results

1.
From the:

· Bid/Pay Item window, click the link at the top of the MOH list to create a new MOH item related to the selected bid/pay item 
· From any other window within a selected contract record, click the New MOH link in the left-hand navigation bar to create a new MOH item
The New Material On Hand Item window appears. Refer to Figure 10.

2.
Item Number—Enter the MOH item number.  
Required field. Item number must be from 7000 to 7999 with an optional letter suffix (e.g., 7001a). It should relate to the corresponding bid item, such as if MOH is for bid/pay item 38, use “7038” as the MOH item number. If more than one type of MOH for the same item, use the optional letter suffix as long as total dollars are justified, documented and do not exceed the available balance for the associated bid/pay item.

3.
Item Group—Enter the bid group associated with the MOH item.
Required field. The MOH group number must match the associated bid/pay item group number.

4.
Item Name—Enter the name of the MOH item.
Required field.

5.
Unit of Measure—Select the appropriate unit of measure for the MOH item.
Required field. When appropriate, use the same units as the bid/pay item. Keep the number of entries to a minimum by including freight charges and incidental small items or hardware all under the major item.

6.
Unit Price—Enter the unit price for the MOH item.
Required field. 

7.
Select Bid Item for this MOH—Select the associated bid/pay item from the drop-down menu.
Required field. If you create the MOH item from the Bid/Pay Item window, this will default to the associated bid/pay item. Otherwise, you must select the associated bid/pay item.

8.
Click Reset to clear and not save the MOH item information you have entered.


9.
Click Submit to save the MOH item.
The new MOH item is saved and appears on the Bid/Pay Items List and Bid/Pay Item window.

Figure 10. New Material On Hand Item Window
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Creating a New Adjustment Item XE "Bid/Pay item:create adjustment" 

 XE "Create:adjustment item" 

 XE "Adjustment:create" 
You may create a new adjustment item from the Bid/Pay Item List, the Bid Item window or any other window within a selected contract record.

NOTE: All entries must have adequate supporting documentation to justify payment. If you have questions, contact Contract Administration at 503-986-3028.

You may create a new adjustment (6000 series) item to:

· Adjust payment for material or work not within reasonably close conformance with contract requirements (see Section 00150.25 of the Standard Specifications)

· Adjust payment to pay a premium price adjustment (bonus) if included in the contract

· Decrease the payment to the Contractor for contract work performed by the agency (e.g., reimbursed costs for an agency-provided weigh technician)

· Assess liquidated damages for failure to complete the project by the specified completion date

· Pay for increased or decreased quantities of work on some lump sum items

· Adjust payment for fuel and asphalt escalation

NOTE: Also refer to other sections of the ODOT Construction Manual on Quality Price Adjustments (12-C) and Adjustments to Lump Sum and Other Items (12-E).

To create a new adjustment item:

Step
Action
Comments/Results

1.
From the Bid/Pay Item List, click New Item in the header or footer of the list to create a new adjustment item related to the selected bid/pay item.
The New Bid/Pay Item window opens.

NOTE: On any other window within a selected contract record, click the New Adjustment link in the left-hand navigation bar to create a new adjustment item. The New Adjustment Item window appears. Refer to Figure 11.

2.
Select New Price Adjustment.
The New Adjustment Item window appears. Refer to Figure 11. 

3.
Item Number—Enter the adjustment item number.  
Required field. Item number must be from 6000 to 6999 with an optional letter suffix (e.g., 6001a). It should relate to the corresponding bid item, such as if the adjustment is for bid/pay item 38, use “6038” as the adjustment item number.

4.
Item Group—Enter the group number associated with the adjustment item.
Required field. If the adjustment is associated with a bid/pay item, the related bid/pay item group number must be used. If not, determine the appropriate group number for the adjustment.

5.
Item Name—Enter the name of the adjustment item.
Required field. For example, enter Statspec Price Adjustment, Lot 1 for a statistically calculated bonus for lot 1, hot mix asphalt.

6.
Unit of Measure—Select the appropriate unit of measure for the adjustment item.
This is typically DOLLAR but could be other unit of measure.

7.
Unit Price—Enter the unit price for the adjustment item.
Required field. The unit price must be a positive dollar amount for a bonus and a negative dollar amount for a price reduction. This is typically +1.00 
or –1.00.

8.
Corrected Estimate Quantity—Enter the current total quantity for the adjustment item.
Required field. Quantities must always have a positive value.

9.
Section Number from Specifications—From the drop-down menu, select the section for the adjustment item.
Required field. This number represents the section number in The Standard Specifications for Highway Construction (e.g., Statspec Price Adjustment would be 0700 for wearing surfaces).

10.
Metric/English—From the drop-down menu, select whether the measure for the item is metric or English.
Required field.

11.
Type of Adjustment—From the drop-down menu, select the type of adjustment code for the adjustment item.
Required field. Choose the type of standard adjustment or choose MISC if nonstandard.

12.
Unit Code—From the drop-down menu, select the unit code for the unit of measure used for the New Adjustment Item.
Required field.

13.
Click Reset to clear and not save the new adjustment item information you have entered.


14.
Click Submit to save the adjustment item.
The new adjustment item is saved and appears on the Bid/Pay Items List and Bid/Pay Item window.

Figure 11. New Adjustment Item Window

[image: image12.png]osoft Intemet Explorer [_[C]x]

Al E- =

sh  Home Mal P

2 Contract Payment System

Q E 9 3

Seach Favores Meda _History

back [ Fohedl . Stn R
s [2] ps /e ottt o s/ cps/pmBia/ndr i TascocormrenBiizoc =] &0 [Links )

[ Home | Oregon Department of Transportation [search]

cozs2a |12 |US26: BADGER GREEK - SIDWALTER RD. BOGUS BOB'S BULLDOZING

New Adjustment Item

Required Field

“ltern Number (5000x-6399x) “ltem Group.

“ltem Name

“Unit of Measure [ACRE =] | “unit Price

“Carrected Estimate Quantity [7.0000

"Section Number from Specifications | &]|

“Metric/English <

°|#-adjustment

°|00-Price Adjustment

“Type of Adjustment <

°|00-Regular

“Unit Cade: <

NI

[ [ 18 @ neret





Creating New Pending Contract Change Orders XE "Bid/Pay item:create change orders" 

 XE "Create:pending contract change orders" 

 XE "Change orders:create" 

 XE "Create:contract change orders"   XE "Contract:change orders" 

 XE "Pending contract:change orders" 
You may create a new pending contract change order item from the Bid/Pay Item List, the Bid Item window or any other window within a selected contract record.

NOTE:  All entries must have adequate supporting documentation to justify payment. If you have questions, contact Contract Administration at 503-986-3028.

You may create a new pending contract change order (98899) item to manage project authorization by adding dollars to the corrected estimate for items such as unapproved change order work or additional anticipated money that is needed for a project.

For example, a project manager may anticipate wetland mitigation and there was no bid item or anticipated item for this work. The project manager can add an amount to the corrected estimate for the anticipated cost of the work. This is then reflected in the estimated cost for the project. From this the project manager can determine the impact of this added work and the need to request more money to complete the project. 

The project manager can create a new pending contract change order (98899) item more than once, but when one is already created then the New Pending Contract Change Order link does not appear in the left-hand navigation bar.

NOTE: Also refer to Chapter 25, Contract Payments section in the ODOT Construction Manual for more information.

To create new pending contract change order item:

Step
Action
Comments/Results

1.
On the Bid/Pay Items List, Bid/Pay Item window or any other window within a selected contract record, click the New Pending Contract Change Order link in the left-hand navigation bar.
The New Pending Contract Change Orders window appears. Refer to Figure 12 below.

2.
Item Name—Enter the name of the pending contract change order item.
Required field.  

3.
Corrected Estimate Amount—Enter the corrected estimated amount for the pending contract change order item.
Required field. Quantities must always have a positive value.

4.
Click Reset to clear and not save the new pending contract change order item information you have entered.


5.
Click Submit to save the pending contract change order item.
The new pending contract change order item is saved and appears on the Bid/Pay Items List and Bid/Pay Item window.

Figure 12. New Pending Contract Change Orders Window
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Pay Notes XE "Pay note" 

 XE "CPS:pay notes" 
A pay note shows the quantity to pay on a project based on work performed and quantities of materials incorporated into a project. The Pay Note function within CPS allows authorized users to add, update and delete pay notes for bid/pay items. As the user changes or adds a pay note record, the system applies business and validation rules. Pay notes may not be deleted after the progress payment has been marked for upload. Users without update authority may only view pay notes.

You may only access pay notes from the corresponding bid/pay item record. In addition, from a selected contract you may only view the pay notes and bid/pay items associated with it. Refer to Bid/Pay Items for more information on bid/pay items.

To view the existing pay notes for a selected bid/pay item:  XE "View:pay note list" 

 XE "Pay note list:view" 
· On the Bid/Pay Item List, click the Pay Notes link for a specific bid/pay item.

· On the Bid/Pay Item window, click the Pay Notes link in the left-hand navigation bar.

Both methods open the Pay Note List for the selected bid/pay item. Refer to Figure 13.

The Pay Note List displays all current pay notes in descending order that are associated with a selected bid/pay item for a specific contract. For each pay note listed, it includes the pay note number/suffix, progress estimate number, remarks, enter and completion dates, quantity, amount and whether the bid/pay item is protected. You may not modify a pay note on a protected bid/pay item as it has already been uploaded to the CPS mainframe.

NOTE:  Refer to Updating an Existing Bid/Pay Item for information on how to lock a bid/pay item to prevent the creation of new pay notes or modification of existing pay notes associated with it. When a bid/pay item is locked, a message appears at the top of the Pay Note List advising of this.

The system makes a pay note view-only once it is sent to the CPS mainframe. It also enters the current open progress estimate number on the pay note when the pay note is created. 

Figure 13. Pay Note List
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From the Pay Note List, you may:

· Return to the Bid/Pay Item window for the current bid/pay item.

· Return to the Bid/Pay Items List, Contract record or Contracts List, or go to another contract or bid/pay item record.

· Go to the next or previous bid/pay item or pay notes using the Fast Item Navigation feature.

· Enter a new pay note for the selected bid/pay item. Refer to Creating a New Pay Note.

· Select a specific pay note to view or update its details (if not protected). Refer to Updating an Existing Pay Note.

· Go to the Progress Estimates window for the contract. Refer to Progress Estimates for more information.

· Create a new MOH item. Refer to Creating a New MOH Item.

· Create a new adjustment item. Refer to Creating a New Adjustment Item. 

· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports or compute mobilization. Refer to CPS Reports for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar.  

Locating specific pay notes XE "Pay note:locate" 

 XE "Locate:pay note" 
To locate a specific pay note on the Pay Note List:

· Scroll through the Pay Note List or

· Use the arrow buttons to view the first, previous, next or last page of the Pay Note List.

Opening specific pay notes XE "Pay note:open" 

 XE "Open:pay note" 

 XE "View:pay note" 

 XE "Pay note:view" 
To open a specific pay note on the Pay Note List:

· Left click on the selected pay note number or

· Right click on the selected pay note number and select Open
When you select a specific pay note to open, the Pay Note window appears. From the Pay Note window, you may view pay note details. If not protected, you may also update the pay note number, suffix, enter date, completion date, quantity or remarks. Refer to Updating an Existing Pay Note. You may also delete an unprotected pay note. Refer to Deleting a Pay Note for more information.

Creating a New Pay Note XE "Create:pay note" 

 XE "Pay note:create" 

 XE "Enter:pay note" 

 XE "Pay note:enter" 
You may create/enter a new pay note for an unprotected bid/pay item on the Pay Note List. Refer to Figure 14 below. When you submit a new pay note, the system applies business rules and validates the data.

NOTE:  Refer to Updating an Existing Bid/Pay Item for information on how to protect a bid/pay item to prevent the creation of new pay notes or modification of existing pay notes associated with it.  

Figure 14. Pay Note List
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To enter or create a new pay note for an unprotected bid/pay item:
Step
Action
Comments/Results

1.
On the Bid/Pay Item List or the Bid/Pay Item window for the selected contract, click the Pay Notes link
The Pay Note List for the selected bid/pay item opens.

2.
Pay Note Number—Enter the pay note number.
Required field. The system defaults the pay note numbers sequentially based on each prior pay note number.

3.
Pay Note Suffix—Enter a suffix to relate the new pay note to a previous/existing pay note, if applicable.
This field is typically used when adding, subtracting or deleting quantities associated with a pay note generated on a previously uploaded progress estimate.

4.
Remarks—Enter any comments about the pay note.
For example, station, location, description, plan sheet number, partial payment, etc.

5.
Date Work Completed—Enter the completion date.
Required field. Format is MM/DD/YYYY.

6.
Quantity—Enter the quantity.
Required field.

7.
Amount—Enter the amount, if applicable. See Comments/Results.
Required field for bid/pay items 800, 9200 and 99999 only. Otherwise, this field is not editable by user. 

8.
Press Enter or click Submit to save the pay note.
The system saves the pay note to the bid/pay item, calculates the Amount and inserts a blank row to enter another pay note on the Pay Note List.

From the Pay Note List, you may also:

· Return to the Bid/Pay Item window for the current bid/pay item.

· Return to the Bid/Pay Items List, Contract record or Contracts List, or go to another contract or bid/pay item record.

· Select a specific pay note to view or update its details (if not protected). Refer to Updating an Existing Pay Note.

· Select a specific pay note to delete (if not protected). Refer to Deleting a Pay Note.

· Go to the Progress Estimates window for the contract. Refer to Progress Estimates for more information.

· Create a new MOH item. Refer to Creating a New MOH Item.

· Create a new adjustment item. Refer to Creating a New Adjustment Item. 

· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports or compute mobilization. Refer to CPS Reports for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar.

Updating an Existing Pay Note XE "Update:pay note" 

 XE "Pay note:update" 

 XE "Modify:pay note" 

 XE "Pay note:modify" 
You may view or update an existing pay note on the Pay Note window. You access this from the Pay Note List.

To open a specific pay note from the Pay Note List: 

· Left click on the selected pay note number or

· Right click on the selected pay note number and select Open.

When you select a specific pay note to open, the Pay Note window appears. Refer to Figure 15 below for a protected pay note and to Figure 16 for an unprotected pay note.

When you first open an existing pay note record, it always contains data that has been received from the CPS mainframe application. If you have view-only authority, you may only view the pay note information. If you have read and write authority, you may update an unprotected pay note.

NOTE:  Contact the CPS system administrator for more information on CPS authority levels.

NOTE:  Refer to Updating an Existing Bid/Pay Item for information on how to protect a bid/pay item to prevent the creation of new pay notes or modification of existing pay notes associated with it.

To update or modify a pay note for an unprotected bid/pay item:

Step
Action
Comments/Results

1.
On the Pay Note List:

· Left click on the selected pay note number or

· Right click on the selected pay note number and select Open.
The Pay Note window opens. Refer to Figure 16 below.

2.
Pay Note Number—Modify the pay note number, if applicable.


3.
Suffix—Modify the pay note suffix, if applicable.


4.
Date Pay Note Entered—Modify the entered date of the pay note, if applicable.
Required field. Format is MM/DD/YYYY.  

5.
Date Work Completed—Modify the completion date of the pay note, if applicable. 
Required field. Format is MM/DD/YYYY.

6.
Quantity—Modify the quantity, if applicable. 
Required field. 

7.
Remarks—Enter or modify any comments about the pay note.


8.
Click Reset to clear and not save the pay note information you have modified.


9.
Click Submit to save the change(s) to the pay note.
The system saves the changes to the pay note, closes the Pay Note and returns to the Pay Note List.

Figure 15. Protected Pay Note
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Figure 16. Unprotected Pay Note
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Deleting a Pay Note XE "Delete:pay note" 

 XE "Pay note:delete" 
You may delete an existing pay note on the Pay Note record. Refer to Figure 17 below.  

NOTE:  When a bid/pay item is protected, you cannot delete the pay note. Refer to Updating an Existing Bid/Pay Item for information on how to protect a bid/pay item to prevent the deletion of existing pay notes associated with it. 

To delete a pay note for an unprotected bid/pay item:

Step
Action
Comments/Results

1.
On the Pay Note List:

· Left click on the selected pay note number or

· Right click on the selected pay note number and select Open.
The Pay Note window opens. Refer to Figure 17 below. 

2.
Check the box at the bottom of the window to delete the pay note. 
Checking this will permanently delete the pay note when you click Submit.

3.
Click Reset to clear the check box if you do not want to delete the pay note.


4.
Click Submit to delete the pay note.
The system deletes the pay note, closes the Pay Note window and returns to the Pay Note List. The deleted pay note no longer appears on the Pay Note List.  

Figure 17. Deleting a Pay Note
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Progress Estimates XE "CPS:progress estimates" 

 XE "Progress estimates" 
A progress estimate (or preliminary progress payment) is the document that summarizes the quantity and value of work completed on a specific contract. It reflects what ODOT should pay to a Contractor for work performed each month. The Progress Estimate function within CPS allows a user to create a progress estimate for a specific contract and mark it for upload to the CPS mainframe application for payment.

Figure 18. Progress Estimates Window
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From the Progress Estimates window, you may:

· Enter/Create a new progress estimate if no open progress estimate currently exists. Refer to Creating Progress Estimates. 

· View errors and update an existing progress estimate. Refer to Creating Progress Estimates.

· Mark an existing progress estimate for upload if no errors exist; click Mark Estimate # for Upload link.

· View the Preliminary Progress Payment Report for the selected contract; click the Preliminary Progress Payment Report link to generate and display the report. Refer to CPS Reports for more information.

· Return to the Contract record or Contract List; click the appropriate link in the left-hand navigation bar.

· Go to a specific contract record to view or update; in the Go To Contract field, enter the contract number and click Go.

· Go to the Bid/Pay Item List for the corresponding contract to view the bid/pay items associated with it; in the left-hand navigation bar, click the appropriate link or enter the bid/pay item and/or group number in the Go To Item fields and click Go.

· Go to the CPS Reports page to generate preliminary progress estimate reports, quantity ledger reports, expenditure reports or compute mobilization and TP&DT; click the Reports link in the left-hand navigation bar. Refer to CPS Reports for more information.

· Create a new MOH or adjustment for a bid/pay item. Refer to Bid/Pay Items for more information.

· Logout of CPS; click the Logout link that appears in the left-hand navigation bar.

Creating Progress Estimates XE "Progress estimates:create" 

 XE "Create:progress estimates" 
You create a progress estimate on the Progress Estimates window. Refer to Figure 18. The process to create a progress estimate involves multiple steps. First, you enter pay notes for the selected contract. Refer to Pay Notes for more information on this.  

You then prepare a progress estimate by selecting the contract that is to be paid. You may either select a partially prepared progress estimate or create a new progress estimate. When you create a new one, the system validates your authority to do this. 

To create a progress estimate and mark it for upload:

Step
Action
Comments/Results

1.
From the Contract record or other page of the contract (e.g., Bid/Pay Items List), click the Progress Estimate link in the left-hand navigation bar.
The Progress Estimates window opens. Refer to Figure 18.

2.
Done to Date—Enter the last day for payment of work performed.
Required field. Format is MM/DD/YYYY.

3.
Estimated Completion Date—Enter the specified or revised project completion date.
Required field. Format is MM/DD/YYYY.

4.
Second Notification Code—Select the appropriate code from the drop-down menu.
Choices include:

· H—Late payment held due to contract issues not resolved by Contractor at time of regular scheduled upload date. Not subject to performance measure.

· N—Regular progress payment and second notification has not been issued.
· Y—Second notification has been issued and this will be the last payment with exception of plant establishment and /or final payment.

5.
Plant Establishment Indicator—Select the appropriate response from the drop-down menu.
Choices include Yes and No. Select Yes if the progress estimate includes payment for plant establishment.

6.
Click Create.
CPS validates that all business rules and edits are satisfied. If any errors exist, then these appear at the top of the Progress Estimates window.

7.
Fix identified errors, if any, and click Update.
Repeat step 5 until no errors occur.

8.
Click the Mark Estimate # for Upload link. 
The Progress Estimates window refreshes and displays the marked progress estimate in the table at the bottom of the window. Refer to Figure 19 for an example of this.

Figure 19. Progress Estimate Marked for Upload
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 XE "Progress estimates:upload" 

 XE "Upload:progress estimates" Once a progress estimate has been marked for upload, you may immediately start on the pay notes for the next progress estimate. In addition, if you view the Preliminary Progress Payment Report, it will show all progress estimates, even those not ready for upload.

NOTE: If important payment information was not entered prior to being marked for upload, the Contract Administration Unit can unmark the estimate you uploaded. They can only do this, however, for progress estimates that have not been altered after the original mark for upload or submitted to the mainframe payments system. You cannot have more than two progress estimates ready for upload at any one time.

After marking a progress estimate for upload, Contracts Administration will review and approve it for upload. This sets the Approved Flag on the Progress Estimates window for the specific progress estimate to Yes. The system automatically generates an e-mail message to the Project Manager when Contract Administration approves a progress estimate for upload. XE "Progress estimates:approved" 

 XE "Approved:progress estimates" 
Once the progress estimate has been uploaded, then the system updates the Uploaded Date on the Progress Estimate window to reflect that the specific progress estimate has been actually uploaded to the CPS mainframe.

CPS Reports XE "CPS:reports" 

 XE "Reports" 
Within CPS, you may generate preliminary progress payment reports, quantity ledger reports, expenditure reports and compute mobilization for a specific contract. You generate these reports from the CPS Reports window. Refer to Figure 20 below.

Figure 20. CPS Reports Window
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You may access the CPS Reports window from most locations within CPS.  Just click the Reports link that appears in the left-hand navigation bar to open the CPS Reports window. 

If you are on a specific contract record when you open the CPS Reports window, then the corresponding contract number appears on the window (as in Figure 20 above).  Otherwise, the CPS Reports window appears blank and you may enter the contract number, and bid/pay item if required, for which you want to generate a specific report. 

Refer to Figure 21 for an example of a Preliminary Progress Payment Report and to Figure 22 for an example of a Quantity Ledger Report. Both examples reflect the corresponding report as it appears when you select a Report Type of Standard.  For more information about the Compute Mobilization Report, refer to Mobilization Report.  Refer to Figure 23 for an example of an Active Project Expenditure Report.
Figure 21. Preliminary Progress Payment Report XE "Reports:preliminary progress payment" 

 XE "Preliminary progress payment report" 
[image: image22.png]& https://www2.odot.state.or.us/tad/cps/report.

Fle Edt View Inset Fomat Iook Table

dex.cfm - Microsoft Internet Explorer

Go Favoites Hep

HEIE

S A

Bk Fousd | Stop  Refiesh  Home

Q &

Seach Favores

& 3

Meda Hitory

Toals

-

Wl P

E

Eo Dissuss

cbess [ s oot s on s aogs .o

ERIEE

specitied
Conplevion
10731708

Y

CNTE A
5025 (041)
comza7z

Bt Yo
Dons To

1

ward: 10/23/2004

01/12/2005 Est Cupl: 03/07/2005

Fantrace no: C53085
Section: USZ6: NT. HOOD HUY @ KELSO ROAD
Highuay: IT HOGD

- Type Vork: GRADE DRATN PAVE STGAL & ST
bag Eny: Cheryl Cave

Contxastor: BOGUS EOB EULLDOZING

Pro) Man: morua hearney

- Sewi Final

~| Toenrp Toem Name

ORIGDNAL CoNTRACT

o001

000z

o003

o004

oo0s

TENPORARY FEATURES AND APPURTENANCES

10 oy-THE-70B TRATNDNG

11 mErLTZaTIN

11 TANP PROT ¢ DIR OF TRAFFIC

1 TRIpoRARY SIGNS

11 TENP EAFRICADES, TYPE III

it
it Price

R
$20.00

s
4100, 000,00

L s
47,000.00

n
$200.00

mcs
$150.00

Original Correctad
Bhorizavian Eerinace
Quancicy Quancicy
s o,

s00. 0000 s00. 0000
$10,000.00 $10,000.00
100. 0000 100. 0000

$100,000.00

$100,000.00

1000000 1000000
$7,000.00 $7,000.00
550000 550000
$11,000.00 $11,000.00
60000 60000
$900.00 390000

e —
To Dace
Quarsity
s

0.0000
40,00

1000000
$100,000.00

0.0000
40,00

0.0000
40,00

0.0000
#0.00

! I

Per fomed since
Last Eetinate
Quanity
s

0.0000
40,00

1000000
$100,000.00

0.0000
40,00

0.0000
40,00

0.0000
40.00

| »

o |w |«

[T 1B nownzene




Figure 22. Quantity Ledger Report XE "Reports:quantity ledger" 

 XE "Quantity ledger report" 
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Figure 23. Active Project Expenditure Report XE "Reports:active project expenditure" 

 XE "Active project expenditure report" 
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Generating Reports XE "Reports:generate" 

 XE "Generate:reports" 

 XE "Reports:create" 

 XE "Create:reports" 
To generate a report for a selected contract record:
Step
Action
Comments/Results

1.
Click Reports on the left-hand navigation bar.
The CPS Reports window opens.

2.
Report Type—Select the type of report desired, if applicable.
Refer to Table 1 for descriptions of available report types.

3.
Contract No.—Enter the contract number.
Required field. If you open the CPS Reports window from a specific contract record, then the contract number automatically appears in this field.

4.
Bid/Pay Item—Enter the bid/pay item, if applicable.
Required field, where applicable. If you open the CPS Reports window from a specific bid/pay item record for a contract, then the bid/pay item number automatically appears in this field.

5.
Click Submit.  
The system generates and displays the report for the specified contract record.  

NOTE:  If you select a Report Type of Excel, the File Download window opens from which you may choose to open or save the report data as a Microsoft Excel spreadsheet.

6.
Close the report window to return to the CPS Reports window.


Printing Reports XE "Reports:print" 

 XE "Print:reports" 
To print a report:

Step
Action
Comments/Results

1.
Generate the desired report from the CPS Reports window.
Refer to Generating Reports above.

2.
Select File > Page Setup from the menu bar.
The Page Setup window opens.

3.
Select the desired page setup options and click OK.
You may want to set the Orientation to Landscape and the Margins to .5.

4.
Select File > Print Preview from the menu bar.
The Print Preview window opens, displaying the report as it will print.

5.
Click Close to close the Print Preview window and return to your report.


6.
Click the Print icon on the browser toolbar to print the report.
The report is printed to your designated printer.

Table 1. Report Types XE "Reports:type" 
Report Type
Description

Standard
The basic report designed for viewing or printing online. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Standard – Excel
The basic report designed to open or save the data in a Microsoft Excel spreadsheet. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Standard – Flat HTML
The basic report presented in a spreadsheet format for viewing or printing online. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Distribution to Contractor 
The Contractor version of the report designed for viewing or printing online. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Distribution to Contractor – Excel
The Contractor version of the report designed to open or save the data in a Microsoft Excel spreadsheet. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Distribution to Contractor – Flat HTML
The Contractor version of the report presented in a spreadsheet format for viewing or printing online. Available for both Preliminary Progress Payment Report and Quantity Ledger Report.

Calculate % Project Complete

(exclude mobilization bid item)
A report for all bid/pay items except one and designed to print and use as a pay note. Only available under report class of Compute Mobilization and TP&DT.

Active Project Expenditure Report
Only available under report class of Expenditure Report.

Mobilization Report XE "Reports:mobilization" 

 XE "Mobilization report" 
On the CPS Reports window, you can select to calculate mobilization totals and generate the Mobilization Report. Refer to Figure 24 for an example of this report.

Payment for the bid/pay item of mobilization is the contract lump sum amount. This amount is paid based on the percent of the original contract amount earned from the other contract bid/pay items not including advances on materials on hand and as follows:

· When 5 percent of the original contract amount is earned, either 50 percent of the amount for mobilization or 5 percent of the original contract amount, whichever is less, is paid.

· When 10 percent of the original contract amount is earned, either 100 percent of mobilization or 10 percent of the original contract amount, whichever is less, is paid.

· When all work on the original contract amount is completed, the amount of mobilization exceeding 10 percent of the original contract amount is paid.

NOTE:  Refer to Section 00210.90 of The Standard Specifications for Highway Construction or the Contract Special Provisions for more information about this. When the contract bid schedule or special provisions do not indicate payment for mobilization, it is considered incidental to the work and no separate or additional payment is made.

When generating the Mobilization Report from the CPS Reports window, you must enter an actual bid/pay item number that exists in the contract and that starts with a number less than the “4.”
You may print this report to use it for the pay note for mobilization. Sign the pay note and enter the correct percentages under the bid/pay item. Refer to Pay Notes for more information.

Figure 24. Mobilization Report
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Error Messages XE "CPS:error messages" 

 XE "Error messages" 

 XE "CPS:troubleshooting" 

 XE "Troubleshooting" 
When Generated/Message
Action to Resolve

Updating Contract Record


Est Completion Date must be a date value.
Re-enter the Estimated Completion Date in MM/DD/YYYY format.

2nd Notification Date must be a date value.
Re-enter the 2nd Notification Date in MM/DD/YYYY format.




Updating Progress Estimate


Done to Date is required
Enter the Done to Date. Format is MM/DD/YYYY.

Revised Completion Date must be a valid date (mm/dd/yyyy).
Re-enter the Estimated Completion Date in MM/DD/YYYY format.

Revised Completion Date is required.
Enter the Estimated Completion Date. Format is MM/DD/YYYY.

Done to Date must be a valid date (mm/dd/yyyy).
Re-enter the Done to Date in MM/DD/YYYY format.




Adjusting Item Value from Pay Note Change


Corrected Estimated Amount/Quantity must be a number.
Enter a numeric value for the estimated amount or quantity.

Corrected Estimated Amount/Quantity must be greater than or equal to the summed Pay Note value.
Enter a numeric value for the estimated amount or quantity that is greater than or equal to the summed Pay Note value.




Creating MOH Item


Bid number must be 7000-7999 followed by an optional letter
Enter Item Number from 7000 to 7999 with an optional letter suffix (e.g., 7001a). It should relate to the corresponding bid item, such as if MOH is for bid/pay item 38, use “7038” as the MOH item number. If more than one type of MOH for the same item, use the optional letter suffix as long as total dollars are justified and documented.

MOH Bid Items require a related Bid Item.
If you create the MOH item from the Bid/Pay Item window, this defaults to the related bid/pay item. Otherwise, select the related bid/pay item from the drop-down menu.

MOH Bid Group needs to match the related Bid Group.
Enter the Item Group number associated with the MOH item.

Error getting standard item code from related bid item.
Contact CPS system administrator.

This MOH already exists, please change Bid No or Bid Group.
Enter unique Item Number or alternative Item Group number.




When Generated/Message
Action to Resolve

Creating Adjustment Item


Bid number must be 6000-6999 followed by an optional letter.
Enter Item Number from 6000 to 6999 with an optional letter suffix (e.g., 6001a). It should relate to the corresponding bid item, such as if adjustment is for bid/pay item 38, use “6038” as the adjustment item number.

All Item Codes are required.
Enter item codes as required.




Updating Bid/Pay Item


Corrected Estimated Amount must be a numeric value.
Enter a numeric value for the Corrected Estimated Amount.

Corrected Estimated Amount must not be less than Performed to Date Amount.
Enter a numeric value for the Corrected Estimated Amount greater than the Performed to Date Amount.

Corrected Estimated Quantity must be a numeric value.
Enter a numeric value for the Corrected Estimated Quantity.

Bid Items or Split Bid Items may not exceed 100 corrected est quantity for LUMP SUM items.
Enter a value of 100 or less for the Corrected Estimated Quantity for lump sum item.

Corrected Estimated Quantity must not be less than Performed to Date Quantity.
Enter a numeric value for the Corrected Estimated Quantity greater than the Performed to Date Quantity.




Creating Pay Note


Seq No must be a whole number.
Enter a valid Pay Note Number.

Enter Date must have a date value.
Re-enter the Date Pay Note Entered in MM/DD/YYYY format.

Complete Date must have a date value.
Re-enter the Date Work Completed in MM/DD/YYYY format.

Quantity must have a numeric value.
Enter a numeric value for Quantity.

Cumulative Quantity for LUMP SUM may not exceed 100.
Enter a numeric value for Quantity so that the cumulative quantity for the lump sum item is not greater than 100.

Amount must have a numeric value.
Enter a numeric value for Amount for bid/pay items 800, 9200 and 99999 only.

Pay note with Seq NO #, SFX No # already exists.
Enter a unique Pay Note Number and/or Suffix.




Updating Pay Note


Pay Note Number must have a numeric value.
Modify the pay note number as needed.

Pay Note Number # with Suffix # already exists.
Enter a unique Pay Note Number and/or Suffix.

Enter Date must have a date value.
Enter the Date Pay Note Entered in MM/DD/YYYY format.

Complete Date must have a date value.
Enter the Date Work Completed in MM/DD/YYYY format.

Quantity must have a numeric value.
Enter a numeric value for Quantity.

Cumulative Quantity for LUMP SUM may not exceed 100.
Enter a numeric value for Quantity so that the cumulative quantity for the lump sum item is not greater than 100.

Amount must have a numeric value.
Enter a numeric value for Amount for bid/pay items 800, 9200 and 99999 only.




When Generated/Message
Action to Resolve

Generating Report


Sorry, no report was specified.
Select a report to generate and click Submit.

Sorry, Contract # does not exist.
Re-enter Contract No. and click Submit.

Sorry, the requested report requires a Contract Number.
Enter Contract No. and click Submit.

Sorry, the requested report requires a Contract Number. Contract Number was undefined.
Enter Contract No. and click Submit.

Sorry, you have insufficient permissions to view Contract #.
Contact CPS system administrator.

Sorry, Bid/Pay Item parameter is completely missing.
Enter Bid/Pay Item and click Submit.

Sorry, missing Bid/Pay Item value.
Enter Bid/Pay Item and click Submit.

Sorry, Bid/Pay Item # does not exist for Contract #.
Enter Bid/Pay Item and click Submit.

Sorry, Bid/Pay Item # is greater than 3900.
Enter Bid/Pay Item number of 3900 or less, and click Submit.

Sorry, Unknown condition occurred.
Contact CPS system administrator.

Sorry, unknown report issue.
Contact CPS system administrator.

Glossary XE "CPS:glossary" 

 XE "Glossary" 
Administrator Access

A level of access to CPS that allows a user to read/view all contract records within the system. This user may also edit any contract records and generate reports for any contract record. The administrator may also authorize other users’ access to CPS, to assign contracts to users, approve progress estimates for upload and perform other miscellaneous administrative activities.

Bid/Pay Item
Deliverable on a contract for a project to be paid by ODOT.

CPEDIT XE "Reports:CPEDIT" 

 XE "CPEDIT" 
The report that prints overnight in a Project Manager’s office and in Contract Services after a progress estimate is uploaded. It includes all changed bid items, followed by all the items beginning with Contract Change Orders (4000 series). If the Project Manager office does not receive the report the following morning, or if it is inaccurate, the Project Manager must contact Contract Services immediately.

NOTE:  The Project Manager should send an e-mail to Contract Services to request a change to an inaccurate progress estimate (for something other than error messages).

CPPROEST XE "Reports:CPPROEST" 

 XE "CPPROEST" 
Contract Payments Progress Estimate and Cost Report. The Region, Project Manager, Revenue Building and Contract Services receive this ODOT CPS mainframe report. It is generated when Contract Payments initiates the payment job after processing an uploaded progress estimate.

CPS

Contract Payment System.

LD

See Liquidated Damages. 

Ledger Report 
Shows a breakdown of all the pay notes entered for each bid/pay item.

Liquidated Damages

Costs charged to a Contractor for not completing all or part of a project on time or for extending lane closures beyond those specified in the contract.

Mainframe 

The ODOT CPS mainframe application sometimes referred to as the “host.”

Materials on Hand

An advanced payment to a Contractor for materials already purchased and stored (or on hand) for a project.

MOB
See Mobilization. 

Mobilization

A lump-sum payment to a Contractor for moving equipment to the job site.

MOH
See Materials on Hand. 

Pay Note
Document showing the quantity to be paid on a contract for a project based on the Project Inspector’s report of work performed and quantities of materials incorporated into a project.

Pay Voucher
The signature sheet copy showing the Contract Administration Engineer’s approval, the person who processed the uploaded estimate and Financial Services verification. This also includes the totals of all current bid/pay items paid or being paid.

PM

Project Manager.

Preliminary Progress Payment Report

See Progress Estimate.

Progress Estimate
A report of what should be paid to a Contractor for work performed each month (if greater than $1,000) as documented by the Project Manager.

Project Manager Access

A level of access to CPS that allows a user to read/view all assigned contract records within the system. This user may also edit assigned contract records and generate reports for assigned contract records.

Quality Note

Documentation on file that verifies the quality of work or material being paid for by ODOT. This may be a laboratory report, a mill certification, results from a test performed by the Project Manager crew, etc.

Super View Access

A level of access to CPS that allows a user to read/view all contract records within the system. This user cannot edit any records but may generate reports for any contract record.

TP&DT
A lump-sum payment to the Contractor for temporary protection and direction of traffic.

View Access

A level of access to CPS that allows a user to read/view only contract records assigned to the user. This user cannot edit any records but may generate reports for assigned contract records.

Zero Estimate

The first progress estimate before payments have been made to a Contractor. Once this first progress estimate is submitted for payment, it is considered number 1.
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If creating MOH from the Bid/Pay Item window, this field defaults to the associated bid/pay item. Otherwise, you must select the bid/pay item from the drop-down menu.











Use the scroll bars to view all of the contracts and information on each page of the Contract List.





Select Previous or Next to quickly move through bid/pay items and pay notes.























Select Previous or Next to quickly move through bid/pay items and pay notes.





Enter search criteria and click Submit to filter the Contract List.











If information is correct, click Submit to request access to CPS.








The Menu Bar




















Use the arrow buttons to view the first, previous, next and last page of the Pay Note List.





Select the report type, enter a contract number and then click Submit to generate the desired report.





Use the scroll bar to view all of the Contract record.





Use the scroll bar to view all of the Preliminary Progress Payment Report.





Use the scroll bar to view all of the Pay Note.





Check here and then click Submit to delete the pay note.





Use the scroll bars to view all of the bid/pay items on each page of the Bid/Pay Item List.





Enter search criteria and click Submit to filter the Bid/Pay Item List.





Enter pay note information and then press Enter or click Submit.





Use the scroll bar to view all of the pay notes on each page of the Pay Note List.





Use the scroll bar to view all of the bid/pay item record.





Use the arrow buttons to view the first, previous, next and last page of Bid/Pay Item List.








Use the scroll bar to view all of the Active Project Expenditure Report.





Estimate 12 is marked as ready for upload but not yet approved.





Use the scroll bar to view all of the Quantity Ledger Report.








Use the scroll bar to view all of the Pay Note.





Estimate 11 was already approved and uploaded.














Enter a contract number and click Go to go directly to the desired contract record or click on the Contract Number.





Enter required information and click Submit to request access to CPS.




























































































Enter your Login Name and PIN, then click Log In to access CPS.














Click Request an Account to request access to CPS.

































































Use the arrow buttons to view the first, previous, next and last page of the Contract List.
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